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BEST 10 TRICKS TO USE IN EXCEL

Check out the top 10 tips below for all those who need a fast dose of advice to develop their Excel skills. Get the most out of this fantastic guide, download the complete 100, and work your way through it.

Let's start then!

1. Conditional formatting   

The noisy world is hard, but crucial, to make sense of our data-rich. Well used, as captured by your spreadsheet, Conditional Formatting brings out the patterns of the universe. This is why Excel experts and Excel users alike voted on no one's most significant feature. It may be sophisticated. But even the smallest improvements in color can be immensely beneficial. Suppose you have volumes sold each month by sales employees. The top 10 percent of performing salespeople can be revealed by only three clicks and an important business discussion can be conducted.

2. TablesPivot

You can be put off learning PivotTables at 4 hours to get to proficiency, but don't be. Use them in one big spreadsheet to sort, count, total or average data stored and display them in a new table, cut as you like. The main thing here is that. It's insignificant if you want to look just at sales figures for some nations, product lines or marketing platforms. Warning: First, make sure your data is safe!

3. Unique Paste

One of the most popular tasks in Excel is grabbing (i.e. copying) any data from one cell and pasting it into another cell. But you may be able to copy a lot (formatting, value, formula, comments, etc.) and sometimes you won't copy it all. The most popular example of this is when you choose to lose the formatting. Your own spreadsheet with your own styling is the place this data is going. To plonk into formatting from elsewhere is irritating and ugly. So just copy the values, and the text, number, whatever the value is, is all you'll get. Alt E S V is the shortcut after the cell is copied (Ctrl C)-simpler to do than it looks. Transpose is the other large one. In seconds, this turns rows and columns around. Alt E S E Shortcut.

4. Add several lines

Ctrl Shift+ is a shortcut, but it really takes longer than just right-clicking on the numbers of the rows to the left of the Excel screen. So our recommendation is Right Click. And if you choose to add more than one row, pick as many rows or columns as you want to add, then right-click and add them.

5. Total Bibliography

Indispensable! Necessary! The dollar fixes the column in front of the letter, the dollar sign fixes the row in front of the number, and F4 toggles through the four possible combinations. With the following exercise, check it out. In cells B1, C1, D1 and three colors in cells A2, B2, C2 (Green, Blue, Yellow), type out three foods horizontally. Now form '=A2&' '&B1' in cell B2. Congratulations: Olives of the Green! Now-and here 's the exercise-add dollar signs so that it gets green as you copy the formula over it. Or just the Granola, but in various colors. Hey! Experiment!

6. Optimization of printing

Everyone's having problems printing from Excel. But imagine if what you were printing was really exactly what you expected. That IS possible. There are a few elements to this: print preview, one-page fit, margin change, print selection, header print, portrait vs landscape, and spreadsheet layout. Invest the time with it to get relaxed. In your professional life, you will carry out this mission many, many times.

7. Extend Formula Across/Down

Its simple scalability is the beauty of Excel. Get the formula correct once, and a million times Excel would turn out the correct calculation. The + cross hair is comfortable. If you have ongoing info, double clicking it will take it all the way down. Copying and pasting (either standard paste or paste formulas) would be easier for you sometimes.

8. Flash Fill

In 2013, Excel formed a mind of its own. There are two columns of names, and from them all, you need to create email addresses. Only do it for the first row, and what you mean will be worked out by Excel and done for the rest. This was feasible before 2013, but it relied on a variety of functions (FIND, LEFT, &, etc). This is much easier now and WILL impress individuals. If Flash Fill (File Options Advanced) is allowed, it should start working just as you type. Or, by pressing Data > Flash Fill, or Ctrl E, get it going manually.

9. INDEX-MATCH

This is one of the most effective Excel feature combinations. You can use this to check for a value in a large data table and return the corresponding value to that table. Let 's say the business has 10,000 employees and there is a spreadsheet with lots of information about them with all of them in it, such as salaries, start date, line manager, etc. Yet you have a 20-strong team and you're just really interested in them. In that table, INDEX-MATCH will look up the value of your team members (these need to be special, such as email or employee number) and return the details needed for your team. As it is more versatile and thus more effective than VLOOKUPs, it is worth getting your head around this.

10. Filters

Quickly explore the data from a chart. Effectively, filtering masks data that is not of interest. There's typically a value that you're searching for (e.g. blue cars) and filters will pull up those and cover the rest. But you can now also filter for number values ( e.g. greater than, top 10 percent, etc) and cell color in more modern versions of Excel. Filtering becomes more effective when you need to filter several columns in combination, e.g. all colors and vehicles to find your blue car. The shortcut (easier than it sounds-give it a go) is Alt D F F. For similar purposes, conditional formatting and sorting serve. Sorting means rearranging the spreadsheet, which may not be ideal and is intrusive. Visualisation brings conditional formatting. Filtering is fast and reliable. Select well.


HOW MANY ARE YOU FAMILIAR WITH?

Push yourself further and download the 100 Excel Tips in full here. Excel experts should know 80 + from the complete list, proficient users 60 + average users 40 + and if you know less than 40, we will classify you as a beginner.

Scan the list for tricks that:

You agree that it would be helpful for you

You really don't know,

Ideally, it's not too long to learn

Study them and become a more effective person if you can find a handful who meet these requirements!

Best and quick way to filter the big data in your spreadsheets;

You can easily find values by filtering information into a worksheet. You can filter through one or more data columns. You can regulate not just what you want to see, but what you want to remove, with filtering. You can filter from a list based on choices you make, or you can create custom filters to concentrate on exactly the details you want to see.

You can search for text and numbers while you filter by using the Search box in the filter interface. When you filter data, if values in one or more columns do not meet the filtering requirements, entire rows are hidden. For cells with color formatting added to their context or text, you may filter numeric or text values or filter by color.

How?

1. Pick the data you would like to filter for 

[image: Example of selected data to sort in Excel]


In the Data tab , click Filter in the Sort & Filter group.

[image: The Sort and Filter group on the Data tab]


To view a list where you can make filter choices, click the arrow in the column header.

Notice: In the list, Microsoft Excel shows either Number Filters or Text Filters depending on the type of data in the column.

1. Filter by value collection or by searching

The fastest ways to filter are to select values from a list and to search. When you click an arrow in a column that has filtering it allowed a list to show all the values in that column.

[image: Filtering data]


To view a list where you can make filter choices, click the arrow in the column header.

Notice: In the list, Microsoft Excel shows either Number Filters or Text Filters depending on the type of data in the column.

1. Filter by value collection or by searching

The fastest ways to filter are to select values from a list and to search. When you click an arrow in a column that has filtering it allowed a list to show all the values in that column.

1. To enter text or numbers to search, use the Search box

2. To view values found in the data column, select and clear the check boxes.

3. To find values that fulfill particular requirements, use advanced criteria

To select by value, clear the check box (Select All) in the list. This removes from all check boxes the check marks. Then pick only the values that you want to see, and then select OK to see the results.

To search for text in a column, in the Search box, enter text or numbers. Optionally, wildcard characters like an asterisk (*) or a question mark?) (can be included. To see the verdict, click ENTER.

1. Filter data with conditions specified

You can build custom filters that narrow down the data in the exact way that you want by defining conditions. By creating a filter, you do this. If you have ever queried the data in a database, this will look familiar to you.

In the list, point to either the Number Filter or the Text Filter. A menu that allows you to filter for different conditions appears.

Choose a condition, then pick the conditions or enter them. To combine criteria, press the And button (that is, two or more criteria that both must be met) and the Or button to enable only one of several conditions to be met.

Click OK to add the filter and get the results you're expecting.

Next steps

Experiment with text and numeric information filters by trying the several test conditions built-in, such as Equals, Does Not Equal, Includes, Greater Than, and Less Than. See Filter data in a range or table for more detail.

Notice Some of these criteria are for text only, and others are for numbers only.

Build a custom filter with several parameters being used. See Filtering using Advanced Criteria for more detail.

Learn how to delete duplicate values or filter for specific values.

How to find, and highlight, grammatical errors;

Spelling and Correcting Grammar

Excel has a built-in spell checker that displays spelling errors in your worksheet as you type them. You may want to modify what Excel recognizes as a mistake, however. To learn how to use the spell checker to easily edit your worksheets, use the following posts.

Tips, Tricks and Answers

Spell search modification for internet addresses

When you check worksheet spelling, you will want to either ignore or check Internet addresses, such as URLs and e-mail addresses, by spelling the checker. This tip explains how you can make a change in configuration that will enforce your desires.

Allowing terms containing numbers

You may want Excel to disregard terms that contain numbers while spell-checking the information in a worksheet. A quick update to the configuration options for the spell-checker is all it takes.

Custom Dictionaries Back Up

The custom dictionary used in Excel includes the spelling-related details that you choose. You might begin to realize after a while how much effort it took to get the dictionary just as you want it. Here's how to bring all the work back up.

Setting Options for Spell-Checking

When inserting data into a worksheet, the spell checker can be helpful. Since the type of information you enter will differ so much from worksheet to worksheet, it is nice that the spell checker can be programmed to either ignore or pay attention to those objects.

Spell Your Worksheet Search

If there are any spelling errors inside it is one of the markers of a well-done worksheet. Any spelling errors that may have crept into your work can be quickly detected and corrected by Excel.

Spell-Checking in a Protected Worksheet

You can't use certain resources, like a spell-checker, when preserving a worksheet. You must unprotect your worksheet, run the check, and then protect it again if you want to use it. By using the macros mentioned in this tip, all of this can be achieved very easily.

Spell-checking Words in Uppercase

Excel's spell-checker usually tests the spelling of upper case words. If your worksheet includes several acronyms, you might not want to search certain terms in the upper case. Here's how the spell-checker can be changed to disregard upper-case terms.

HOW TO FORMAT CELLS RELATIVE TO WHAT'S INSIDE;

All Excel users should understand how cells in a worksheet are referenced by Microsoft Excel. We mean a cell's row-column address by cell reference; e.g. G44, A3. Understanding this would help Excel users be more efficient and ensure the accuracy of information as well.

Excel switches cell references when you copy and paste a formula from one cell to another! Yup. Yup. Yup. That's generally a pretty nice thing now, but sometimes it's not. We will show you why this is happening and how, where necessary, to prevent it. But first, let's see how these cell addresses are interpreted by Excel.

In Formulas, how Excel interprets cell references

In formulas, Excel interprets cell references in a 'relational' way. It looks at how on the grid of rows and columns, the cells relate to each other, positionally. We need to look at a basic math formula to explain this.

Sum the contents of cells A1 and A2, then put the total in cell A3--see the spreadsheet image below.

The formula in cell A3 is also shown in the formula bar of the worksheet: = A1 + A2. (See Excel Math Fundamentals if unfamiliar with writing math formulas).

[image: Excel spreadsheet example showing how Excel interprets cell references in a relational manner]


"This is how the formula in cell A3 is interpreted by Excel:" Take the number in the cell in my segment, however two lines above me, add it to the number in the cell in my line and one cell above me and put the appropriate response in that cell.

Relative Cell Reference

When you write cell addresses in the easiest way, e.g. This is called a relative relation (A1, B3).

A relative relation is considered the simplest cell relation: A11

Excel can change the number of the row and the letter of the column when copying a formula when pasting

Most Excel users write the addresses of the cells as relative reerences. In fact, many users do not know that there is any other way for a cell address to be written. When a formula is copied to and pasted, Excel automatically changes the row and column letter according to the cell 's address into which the formula is pasted.

This is one of Excel's most basic features , making it so strong. Typically, that is what Excel users want to do as they copy and paste formulas into a spreadsheet.

For instance, if we copy the formula in cell A3 (= A1+A2) and paste it into cell B3, Excel will change the formula to read = B1+B2, etc. for column C , D, etc. That's nice, since the most common use of an Excel spreadsheet is possibly to tabulate column totals and row totals, so this default behavior makes us super efficient.

But what if you want to copy or move a formula, but DO NOT want Excel to automatically update cell references each time?There are circumstances where, where you copy or transfer it, you don't want Excel to alter any or all cell references in a formula. Use an absolute cell reference in your formula in those cases. Below is an absolute cell reference description, and then an instance of a worksheet.

There are dollar signs on an absolute cell reference

Before the row and column: $A$ 1

When it is copied or transferred, Excel will NOT alter the cell address.

Examples of Absolute Reference Use

We want to split each number in Row 2 by the number in A1 in the Excel spreadsheet below, and put the responses in Row 3. For the first column in cell A3, the formula is = A2 / A1. Excel will change the formula to = B2 / B1 if we copy this formula to cell B3, or show # DIV/0! Mistake if either cell is empty. In any formula, we want A1.

Instead, for cell A1, we use an absolute cell reference and write the formula as = A2/$ A$ 1. Then the formula is changed to = B2/$A$1 when we copy the formula from cell A3 to cell B3, as seen in the formula bar of the worksheet-which is what we want. And = C2/$A$1 would be the formula in cell C3, and so on.

Test Excel worksheet showing an absolute cell relation

And A1 will never be altered while we begin copying and pasting.

Three Cell References Forms

Let 's review now. Currently , there are three sorts of references to cells. We will address the third form briefly below.

Relative reference

A relative relation is considered the simplest cell relation: A1. This is the way most users reference cells in a spreadsheet while running. Excel can alter the cell address when copying or moving to hold it relative to its original location. When conducting the same calculation on several columns or rows, this is most beneficial.

Absolute Reference

'Wrapped' with dollar signs is an absolute cell reference: $A$ 1, in order to say Excel to never change the cell 's address while copying or traveling. This is used when several columns or rows are measured, but the value of a single cell should always be used.

·Mixed Reference

A hybrid, the mixed relation, does not alter or anchor either the column or the row portion of the cell address: $A1 or A$ 1. A mixed reference tells Excel not to alter, when copying or moving, either the row or column portion of a cell address.

FORMULAS RELATED TO PERFORMING MATHEMATICAL CALCULATIONS ON DATA SUCH AS SIMPLE OPERATIONS OR PERCENTAGES AND OBTAINING DATA IN REAL TIME;

In many aspects of life, estimating percentage is beneficial, whether it's restaurant tipping, reseller commission, the income tax or interest rate. Say, on a new plasma Screen, you were fortunate enough to get a 25 percent off promotion code. Is this a nice deal? How much would you have to pay eventually?

Basics of percentage

A percentage is a fraction of 100, which is calculated by dividing the numberer by the denominator, multiplying the result by 100, as you probably do from the high school mathematical class. The basic formula for percentages is as follows:

(part / whole)*100 = Percentage

For instance, if you had 20 apples and you gave 5 to your friends, how much, percentage wise, did you give? You get the answer-25 percent by performing a simple calculation = 5/20 * 100.

In school and daily life, this is how you generally measure percentages. The percentage of computation in Microsoft Excel is also better, as Excel automatically performs certain operations in the background for you.

Regrettably, for percentages, there is no universal Excel formula that will cover all conceivable scenarios. If you ask someone, "What percentage formula do I use to get the result I want?" you will most likely get a response like, "Well, that depends on exactly what outcome you want to achieve."

So, let me show you a few basic formulas, such as a percentage increase formula, a formula to get percentages of a total and more, to measure a percentage in Excel.

Basic percentage formula for Excel

In Excel, the basic formula for calculating the percentage is this:

Total / Part = Percentage

If you compare it to the percentage simple math formula, you will find that the * 100 part is missing from Excel 's percentage formula. If you calculate a percentage in Excel you do not have to multiply the resulting fraction by 100 because Excel automatically does this when the percentage format is applied to a cell.

And now, let's see how the Excel percentage formula can be used for real-life results. Suppose you have the number of items you have ordered in column B and the number of items shipped in column C. Perform the following measures to find out the amount of goods delivered:

In cell D2, enter the = C2 / B2 formula, and copy it down to as many rows as you like.

Click the Percent Style button to show the resulting decimal fractions (Home Tab > Number Group).

As illustrated in Percentage Tips, remember to increase the number of decimal places if necessary.

Done! : )

When using some other percentage formula in Excel, the same series of steps must be followed.

Calculating in Excel the percentage of the total

The above example is, in fact, a simple case of measuring the percentages of a number. Now, let 's look at a few more examples that will help you do a fast job of estimating a percentage of the total on various data sets in Excel.

Example 1. Example 1: The total in a certain cell at the end of the table is

When you have a total at the end of a table in a single cell, a very common scenario is In this case, with the only exception that a cell reference in the denominator is an absolute reference (with), $the percentage formula would be identical to the one we have just discussed. The dollar sign sets the cell relation, so it never changes anywhere the formula is copied. For instance, if you have some values in column B and their total in cell B10, to calculate percentages of the total, you can use the following formula: = B2/$B$10

You use a relative cell reference for cell B2, so when you copy the formula to other cells in column B, you want it to be updated. But you enter $B$10 as the absolute cell reference because, when you auto-fill the formula down to row 9, you want to keep the denominator set on B10.

Tip.Tip. Tip. To make the denominator an absolute reference, type either a dollar sign manually ($or click the cell reference in the formula bar and then press F4.

E.g. Parts of the total are in multiple rows

If you have more rows in the above case for the same product and want to know what part of the sum is generated from all the orders of that particular product.

In this case, the SUMIF function allows you to add all the product numbers first and then divide the total by:

= SUMIF(range, requirements, range sum) / total

For more information about the SUM feature, please check out the following tutorials:

How to use Excel's SUMIF feature

SUMIFS and SUMIF with various parameters for Excel

How to measure changes in percentages in Excel

Of all formulas for percentage calculation in Excel, the formula for percent change is probably the one you will most frequently use.

Excel percentage shift formula (percentage increase / decrease)

Using the following formula to measure the percent change between values A and B:

Percent Change = (B-A) / A

It is crucial that you correctly determine which value is A and which is B when applying this formula to the actual data. You had 80 apples yesterday, for instance, and you had 100, which means you now have 20 apples more than before, which is a 25 percent rise. If you have 100 apples and now you have 80, you've reduced the number of apples by 20, a 20 percent reduction.

The Excel formula for the shift in percentage takes the following form:(New Value-Old)/Old Value

And now, let's see how this percentage change formula (aka Excel percentage increase formula) will use your spreadsheets.Example 1. Example 1: Percent shift estimate between 2 columns

Suppose you have the prices for the last month in column B and the prices for this month in column C. To measure the percentage change in your Excel sheet, you can then enter the following formula into cell D2:

= (C2-B2)/B2 B2-B2

The percentage increase / decrease this month (column C) compared to last month (column B) is determined by this percent change formula.

Remember to press the Percent Style button on the ribbon after copying the formula to other rows to display decimals as percentages and you will get a result close to what you see in the screenshot below. Positive percentages showing percentage increase are formatted in ordinary black in this example, while negative percentages (percent decrease) are formatted in red using the technique mentioned in this tip.

[image: Excel formula to calculate percent change between 2 columns]


E.g. Example 2. Calculating the change in percentage between rows

If you have one column of numbers, say column C, which lists weekly or monthly sales, you can use this formula to measure the percentage change:

= (C3-C2)/C2 C2

Where the 1st is C2 and the 2nd cell with data is C3.

Memo. Note. Please note that the first row of data should be skipped, and your Excel percentage formula should be placed in the second cell, which is D3 in this case.

You will get the following result after applying the percent format to the column with the percent shift formula:

[image: Excel formula to calculate percent change between rows]


If you want to measure a percentage change compared to a certain cell, you need to use the absolute cell reference with the $sign to correct the reference to that cell, e.g. $C$ 2.

For example, here is the formula for the Excel percentage change that calculates the percent increase / decrease for each month compared to January (C2):

= (C3-$C$2)/$C$2)/$C$2-

The absolute reference ($C$ 2) will remain the same when you drag the formula down to copy it to other cells, while the relative reference (C3) will change to C4, C5 and so on.

[image: Calculating a percentage change compared to January]


Quantity estimation and total by percentage

Calculating percentages in Excel is simple, as you've just seen, and so is calculating amounts and totals if you know the percentage.

Example 1. Example 1: Calculate the overall and percentage numbers by

Suppose you are purchasing a new laptop for $950 and on this purchase they charge 11 percent VAT. The question is-how much do you have to pay in addition to the net price? In other words, what is $950 at 11 percent?

The formula that follows will help:

Total * Percentage = Quantity

The above formula transforms into a simple = A2 * B2 and returns 104.50., assuming that the total value is in cell A2 and percent in B2.

[image: Calculating amount by total and percentage]


Note, the number is interpreted as a hundredth of its value when you type a number followed by the percent sign (percent) in Excel. 11 percent, for example, is simply stored as 0.11 and in all formulas and equations, Excel uses this fundamental value.

The formula = A2 * 11 percent is equivalent to = A2 * 0.11 in other words. Naturally, if this works better for your worksheets, you are free to use the decimal number equivalent to the percentage directly in a formula.

Example 2. Complete by number and percentage measurement

For instance, for $400, your friend gave you his old computer, which is 30 percent off the original price. You want to know what the price was for the original.

Since 30 percent is the discount, you first subtract it from 100 percent to see what amount (100 percent-30 percent = 70 percent) you actually have to pay. To measure the original price, you need the formula now, i.e. to find the number of which 70 percent equals 400.

The formula goes as follows:

Amount / Percentage = Total

It take any of the following forms, applied to real data:

= A2 / B2 or = A2/70% = A2/0.7

[image: Calculating the total by amount and percentage]


How to increase / decrease the percentage of the amount

The holiday season is upon us, signaling a change in your daily weekly spending. To find your optimal weekly allowance, you may want to weigh various choices.

Using this formula to raise the sum by a percentage:

= Amount * (1 +%)

For instance, the formula = A1*(1 + 20%) increases the value by 20% in cell A1.

To minimize the sum to a percentage:

= Quantity * (1 -%)

For example, the formula = A1*(1-20 percent) reduces the value by 20 percent in cell A1.

If A2 is your current expenditure in our example and B2 is the percentage by which you want to increase or decrease that number, here are the formulas you will enter in cell C2:

Percent increase: = A2*(1+B2)

Percent reduction: = A2*(1-B2)

[image: Excel formula to increase a number by percentage]


How to increase / reduce a whole column percentage

If you have a column number that you want to increase or decrease to a certain level, and you want to have changed numbers in a single column instead of adding a new column with the form. To manage this job, here are 5 quick steps:

In this example, insert all the numbers you want to increase or decrease in a certain column, column B.

Enter one of the formulas below in an empty cell:

Percentage increase: = 1 + 20 percent

Reduce by percentage: = 1-20 percent

[image: A formula to increase an entire column of numbers by a certain percentage]


Of course, you are free to replace 20 percent with the percentage you want in the above formulas.

Select the cell (in our case C2) and copy it by pressing the formulation

Select the formula cell (in our case C2) and copy it by clicking on Ctrl + C.

Pick the cell spectrum to adjust, right-click on the list and then click Special paste ...

[image: Use Paste Special to increase an entire column of numbers by percentage]


In the Paste Special dialog window, select Values under Paste, Multiply under Operation and click OK.

[image: In the Paste Special dialog window, select Values under Paste, Multiply under Operation.]


And here's the result - all the numbers in column B are increased by 20%:

[image: All the numbers in column B are increased by 20%.]


You may multiply or divide a number column by a certain percentage. Insert the target percentage in an empty cell and follow the steps above.

This is how, in Excel, you measure the percentage. And even if dealing with percentages has never been your favorite kind of math, you can get Excel to do the job for you by using these simple percentage formulas.


USEFUL EXCEL SHORTCUTS TO SAVE TIME

Here is a list of the useful Excel keyboard shortcuts. These can help you become even more productive and give more time for your data to be analyzed and visualized.

1. To run 'File' operations:

Ctrl + N: To build a new workbook for Excel

Ctrl + O: Opening the Excel workbook needed

To save the latest active excel workbook, Ctrl + S:

F12: This shortcut key is used to access the "Save As" option directly. Using this option, the user can save the file at the location of the appropriate folder.

Ctrl + F4: It is used to close the Excel workbook that is currently active

2. In Excel Sheet to conduct "General" operations

Ctrl + Z: Use this shortcut to "delete" the last change that was made to the excel document.

Ctrl + Y: Apply this shortcut to "redo" the last Excel sheet update.

F4: To replicate the last operation that was done,

Ctrl + X: To cut selected cell values

Ctrl + C: To copy selected cell values. In the clipboard, the copied values are stored

Ctrl + V: To paste the values you have copied into the selected cells,

Ctrl+Alt+V: The "Paste Special Box" is shown with this shortcut key. "Paste Special Box" provides various types of paste choices, such as just paste values, formatted paste values, formula paste values, etc.

Ctrl + F: This key shows the "find and replace" option that allows a user to check for a specific keyword in an Excel document.

Ctrl + H: This Replace Key Display option allows a user to replace a specific word with another word.

3. Alt + A + T: The user can place the "filter" option directly on the data table using this shortcut key.

Alt+A+C: This shortcut key removes all filters from the data table added to the filter.

Alt + A + M: This is used to eliminate duplicates from the table of data picked.

Alt + A + S + S: To sort the selected data table based on the appropriate fields, use this shortcut key

Alt + H + M + M: This is also the shortcut key for combining several cells into one single cell.

Alt + H + O + I: To change the width of selected cell columns

Alt + H + E + A: You can also use this to remove all the contents of the cells picked. Note that this shortcut key also removes all of the cell formatting along with the content.

Shift + Spacebar: Use the entire row to be picked

Ctrl + Spacebar: Use the entire column to be picked

Alt + I + R: A row is inserted

Alt + I + C: Column insert

4. To navigate between sheets of Excel:

Ctrl + PgDn: To navigate on the right-hand side through the excel sheets

Ctrl + PgUp: To navigate on the left side through the excel sheets

PgDn: Use this key to navigate to a row in the Excel sheet that is involved.

Ctrl + Right Arrow: To navigate to the data table 's extreme right-hand end

Ctrl + Left Arrow: To navigate to the data table's extreme left end

Ctrl + Up Arrow: To navigate to the data table 's extreme top end

Ctrl + Right Arrow: Navigate to the extreme end of the data table at the bottom.

Ctrl + Home: In the active excel sheet, to transfer the cursor to the first cell,

Ctrl + End: In the active Excel sheet, to transfer the cursor to the end cell,

5. In the excel sheet, to select the data:

Shift + Left / Right Arrow: To expand the left / right selection of one extra cell from the current selected cell.

Shift + Up / Down Arrow: To expand the up / down selection of an extra cell from the current selected cell.

Ctrl + Shift + Left / Right Arrow: To expand cell selection from the current selected cell to the far right / left end of the data table.

Ctrl + Shift + Up / Down Arrow: To expand cell selection until the last cells are up / down from the current selected cell table.

Shift + Home: Selects all cells from the current cell to the beginning of the cell, with this shortcut key.

Shift + End: This shortcut key will pick all cells from the current cell to the end of the cell.

6. To pick a special cell type:

Ctrl + Shift + O: This main user will pick cells with comments directly.

Ctrl + /: Pick the current array with this key.

Alt +;: This shortcut key selects visible cells

7. For directly editing the selected cell:

F2: This allows the user to edit an active cell that is not active.

Shift + F2: The user can directly access the edit mode of comments present in the cell using this shortcut key.

Alt + Enter: In the same active cell, to start a new line,

8. To define the data in the cells:

Ctrl +;: In the selected cell, to reach the current date,

Ctrl + Shift +:: In the selected cell, to reach the current time,

Ctrl+D: Fills the top cell value until the end of the selected cells with this shortcut key.

Ctrl +: 'This shortcut key will copy the formula of the top cell and paste it to the end of the selected cell.

Ctrl + Shift +: "This shortcut key will copy and paste the top cell value until the end of the selected cell."

9. To do number formatting and cell formatting formatting, such as borders:

Ctrl + B: Add or delete the bold formatting in the cell text

Ctrl + I: Add or delete the italic formatting in the cell text.

Ctrl + U: To add or disable the underline formatting in the cell text,

Alt + H + A + C: Align the text of a cell to the middle to apply

Alt + H + A + R / L: Align the text of a cell to the right / left to apply.

Ctrl + Shift + Percent: To convert the cell number to a percentage, i.e. to add percentage formatting.

Ctrl + Shift + #: To add date formatting to the cell you have selected

To add time formatting to a selected cell, Ctrl + Shift + @:

Ctrl + Shift +! : Apply numbers to a selected cell

Alt + H + B + A: To apply the formatting of All Borders to the current selected cells

Alt + H + B + T: To add the formatting of Thick Outside Borders to the current selected cells

Alt + H + B + H: To add the formatting of Thick Bottom Border to the current selected cells

Alt + H + B + N: To exclude any border formatting type from the currently selected cells

How to render excellent file lighting based on the use of various saving formats;


TIPS FOR EXCEL FILE SIZE REDUCTION

You can use the method below to reduce your Excel workbook's file size.

I did some testing for each tip and added the snapshots to show you the effect on the file size. Depending on your data and files, the findings you get can vary.

You can use one or more of those tips depending on your workbook.

Delete Redundant Data / Worksheets

The best methods are also the easiest.

This strategy is more common sense and less of the wizardry in Excel.

See if you can get rid of them if you have an Excel workbook that has any worksheets that are not needed (and are not included in any formulas).

This is directly proportional to the file size of Excel. So you can immediately see a reduced file size as soon as you remove some of the worksheets and save the workbook.

To Binary Format (XLSB) Convert

Do you know that the file size can only be decreased by saving an Excel file in the XLSB format?

It's real, yes.

Only use the xlsb file format when saving a workbook.

To do this, here are the steps:

Click the File tab icon.

Save As is pressed.

Uh, click Browse.

Adjust the file form in the Save As dialog box to Excel's Binary Workbook (.xlsb)

What's XLSB here?

It is saved in XML format when you save an Excel file (.xlsx or .xlsm).

For instance, if I change the XLSX file extension to ZIP and then open it, that's what I get.

XLSB Vs XLSX / XLSM Vs XLSX

Size reduction is a major advantage when it comes to using the XLSB format. But when dealing with the XLSB format, you need to be a little careful.

Benefits of the XLSB format:

The Excel file size is reduced. When you have big files and you want to share them via email, this can be helpful. By saving it to XLSB, you can easily reduce the size.

XLSB files tend to be quicker to open and save than XML files. XLSB files were opened and saved 25% -50 percent faster, based on the minimal tests I did. In wide Excel files only, this difference is evident. With files that are smaller, both XLSB and XLSX are fast.

Although XLSB looks fantastic, you should stick to using XLSX / XLSM files for a few reasons:

With the XLSB file, you don't know whether or not it has a macro. As anyone can use it to execute malicious code, this makes it riskier.

XLSB files are encoded in a proprietary bin file format, while XML is an open source file format that can be read. This means that it's easier to use the XML format if you're using third-party Excel software.

The Power Query can not read the XLSB file 's data. So, it's easier to have your data in XLSX / XLSM formats if you use Power Question.

As a general rule, it is best to stick to the XLSX / XLSM format if your file size is limited (less than 5 MB)

A lot of people tend to use XLSB as the file format when it comes to using Excel, based on what I have learned from people and read on many forums.

Here is a good article on XLSB format comprehension.

Delete Formulas Unnecessary

Your workbook file size can become bloated by so many formulas.

So it's easier to translate these formulas into values if you have a data set that you need, but don't need the formulas in it.

Here are the steps for translating formulas to values in Excel quickly:

Pick the worksheet / dataset in its entirety.

Click the key to F5.

Tap on 'Special' in the Go To dialog box.

Pick Formulas in the Go To Unique dialog box.

Only click OK.

Now, to translate these formulas into values, use the steps below:

Copy cells that are picked (control + C)

The Home tab is pressed.

Click on Paste in the Clipboard group.

Click on the Value Icon Paste button.

(Before and After Upload) Compress Photos

You need to optimize these images to make sure the size is smaller if you deal with Excel files that have images in them.

The issue with photos is that there is also a decrease in quality when you compress them, which you do not like.

The easiest way to keep the size of your Excel file minimal when dealing with images is by compressing the images until you paste them into Excel.

TinyPNG (or you can use Photoshop or some other other related application) is a decent online application to do this.

It is a free tool that can reduce an image 's size by up to 90% and still retain good image quality.

After you have imported these compressed images to Excel, you can use Excel 's built-in option to compress them further.

Here are the steps in Excel for compressing an image:

Pick the image to be compressed.

Tap on the Format tab for Image Tools. This is a contextual tab which appears only when a picture is clicked.

Click on the 'Compress Photo' option in the Change group.

In the Compress Images dialog box:

Uncheck 'Apply to this image only' if you want to compact all the pictures in your workbook.

For maximal compression, pick Email (96 ppi).

Only click OK.

Only save the file.

To Save Space, remove the Pivot Cache

Knowing the Pivot cache can be beneficial if you are dealing with Pivot tables and struggling with massive Excel files.

Excel automatically generates the Pivot Cache when you create a pivot table using a data set.

The pivot cache is an entity holding a replica of the source of the data.

It is a part of the workbook, although you can't see it, and is connected to the Pivot Table. If you make any modifications to the Pivot Table, the data source is not used, but the Pivot Cache is used instead.

Although you assume that you are directly connected to the source data, when you make adjustments to the pivot table, you simply access the pivot cache (and not the source data).

Now that you're making a replica of the data set, some space is needed.

So, as soon as you create the Pivot table, you'll note an increase in the size of your Excel file.

In the example above, as soon as I add the Pivot table, the file size increases by two times.

Now, when dealing with Pivot tables, there are two ways you can decrease the file size.

Keep the data from the source and remove the Pivot cache

Retain the Pivot Cache and delete the source data from the source.

Let 's look at these methods, both of them.

Keep data from the source and remove the Pivot Cache

You can force Excel to save only the source data and the corresponding Pivot Table, not the Pivot Cache, when you are finished with the Pivot Table and saving it.

Doing this would make your Excel file lighter, and you can restore the Pivot cache when you need it next time.


T
o NOT save the Pivot Cache, here are the steps:

In the Pivot Table, pick any cell.

Tap the Button Examine.

Click on the 'Options' Pivot Table button.

Click on the Data tab in the Pivot Table Options dialog box.

Uncheck 'Save source data with disk' in the Pivot Table Data options. This option makes sure that when you save the workbook, the Pivot Cache is not saved (and helps to reduce the Excel file size).

Check the 'Refresh data when the file is opened' option. This choice ensures that the Pivot Table is refreshed and the pivot cache is automatically created as soon as you open the workbook. If you do not check this option, in order to generate the Pivot Cache, you will have to refresh the Pivot table manually.

Only click OK.

Now, when you save the Pivot table file, you'll find that the file size is reduced.

Hold the cache of the Pivot and delete the source data

Another way to decrease the size of an Excel file is to remove the Pivot Table source data and retain just the Pivot Cache.

This works because the Pivot Cache is a mirror copy of the data, and when you make adjustments to the Pivot Table, you can not access the source data, but use the Pivot Cache instead.

Only delete the data (either by removing the data or the data worksheet) to do this.

If you desire to get the source data back, double-click the Pivot table's 'Grand Sum' cell and it will automatically generate the entire data collection in a new worksheet.File Compress (ZIP IT)

Outside of the Excel program, this is something you can do.

You'll see a size reduction of around 10-15 percent instantly when you zip an Excel file.

This zip file can then be exchanged via email, and the recipient can unzip the file and use the Excel workbook.

Here are the steps for zipping an Excel (Windows) file:

Right-click on the file for Excel

On the Send to choice, hover your cursor.

Click on the option 'Compressed (zipped) folder'.

This generates a zip file for your selected Excel workbook.

Delete Formatting for Data

Data formatting may all be applied to the file size, such as applying a background color, inserting borders, or modifying font styles.

While I have found, based on my experiments, that it does not have a major effect.

The sizes below are 2 Excel workbooks, the first one with the same size (cell colour, edge border and italicized), but formatting is applied to the workbooks.

Below are the steps to delete all the formatting immediately, while keeping the details intact:

Highlight the whole dataset (which you would like to delete the formatting from).

Select the “Home tab” menu.

Click on 'Clear' in the Editing group.

Select the 'Clear Formats' menu.

Then save the worksheet.

Remove Conditional formatting

Conditional formatting also leads to the file size, much like standard data formatting.

I find that the difference is smaller, however, based on my experiments (unless you have multiple rules applied to multiple sheets with large datasets).

Nevertheless, eliminating conditional formatting from any dataset where you do not need it is a smart idea.

There is another good reason, apart from the scale, to eliminate conditional formatting-SPEED.

Conditional formatting is unpredictable and it recalculates if there is some change in the worksheet. This can lead to a workbook that is slower.

Hi dear reader, I'm glad you downloaded my Free book.

If you want to become a true expert, I recommend you to discover these two or the bundle books.



Excel 2019: A Basic Guide for Beginners, the Real Bible to Learn Formulas, Methods and Use of VBA






Excel 2019: How to Use Formulas and Functions in Real Life and Your Business, an Easy Guide to Boosting your Productivity and Master Spreadsheets






Excel 2019: 2 Books in one, A Basic Guide for Beginners + How to Use Formulas and Functions in Your Business, to Boosting your Productivity and Master Spreadsheets




What are you waiting for? Click on top, and become a true Excel expert.


if you want to know more about the author,
 click here
.
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